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4 Weather Message - EMWIN Retransmission

1 Introduction

Enter topic text here.

1.1 Overview

Weather Message - WxReTran is an EMWIN data retransmission program. It is used to
retransmit EMWIN data on a VHF or UHF frequency using a radio modem.

WxReTran features 10 priority message queues, message discarding, message duplication and
message scheduling. In addition, it can be used to compress single or multiple messages.

A standard RS-232 connection to an external radio modem is used to transmit the EMWIN data
at 1200, 2400 or 9600 baud. Radio modems, suitable for EMWIN retransmission can be
purchased at Tigertronics http://tigertronics.com or Zephyrus Electronics http://big-z.com . See
Appendix B for specifications.

An appropriate radio transmitter and FCC license are required to broadcast the EMWIN data.
NOAA currently has frequencies available for EMWIN retransmission. They are 163.300,
163.325, 163.350, 168.7125, and 168.8125 MHz. Contact your local Warning Coordination
Meteorologist (WCM) for information on applying for a frequency.

Transmitters certified for use on the NOAA frequencies can be purchased from Skywarn
Systems, Inc. For information and pricing, send email to Ray Bartik —
ray.bartik@skywarnsystems.com.

Weather Message — WxBBSrvr is an EMWIN data retransmission program for the internet. Itis
used to serve EMWIN data to a private or public network.

Weather Message — WxRadar can be used to retrieve weather radar images for inclusion in your
retransmission.

Weather Message - WxReTran can be downloaded from the Internet at http://www.wxmesg.com

Weather Message

Weather Alerting Software

http://www.wxmesg.com

Copyright © 2010 Weather Message Software

1.2  Data Warning
Warning

Due to the nature of the EMWIN , Weather Wire , and NOAAPORT data streams, it is possible, on
rare occasions, for weather messages to be missed or not processed. This can be caused by

© 2010 Weather Message Software



Introduction 5

1.3

1.4

satellite black out, technical problems, weather conditions, poor Internet connections or corrupted
messages. Weather Message makes deliberate attempts to process all received messages, even
those that may have been corrupted. Because of this, the expiration times of some messages may
be set to a default of 30 minutes or 72 hours. With any watch or warning, you should read the text
of the message to validate the expiration time.

Obtaining Help

Email Support
If you need help with Weather Message, send an email to help@wxmesg.com.

Mail Support
You can reach the program author by mail to Weather Message Software, 203 Old Shepard
Road, Dadeville, Alabama 36853.

Weather Message Website
You can check for software updates and information on the Weather Message Website.

Discussion Group
A Yahoo Discussion Group has also been established for users to exchange ideas and help each
other. You can join this group at http://groups.yahoo.com/group/WxMesg/join.

Installation

Weather Message Retransmission can be purchased on CD or downloaded from the website.
The CD will automatically load the installation program. If you download the software from the
Internet, you will need the full installation executable. It contains all of the files necessary for a
full installation.

Updates to the software can also be downloaded from the Internet. The program updates only
contain changes to the Weather Message programs. It cannot be used for a full installation.

Weather Message Retransmission can be uninstalled using the standard Windows Add/Remove
Programs facility. The uninstaller will not delete files created while running Weather Message.
After uninstalling the software, you can safely remove the WxMesgNet directory.

Note: If your installation will use multiple user login names/profiles, we recommend that you
install Weather Message using the administrator login. This will insure that all users have
access to the programs.

Note: It is not necessary to uninstall a previous version of Weather Message Retransmission
before installing an updated software version. Uninstalling the software will delete your
operating setup information.

© 2010 Weather Message Software









8 Weather Message - EMWIN Retransmission

2 WxReTran - Serial Port Retransmission

2.1 Overview

WxRetran is used to retransmit EMWIN data using a modem connected to a VHF or UHF radio.

-« EMWIN ReTransmission Engine - By Weather Message

File  Help
Sending = FILLFILE.TAT Block 1 ©f 1 & | Filez Sent: a
Tranzmitting 1200 BPS Comprezsion Fatio = 1:1 Throughput = 1200 BPS
Pricrity 1 Pricrity &
Pricrity 2 Pricrity ¥
Priority 3 Priority 8
Pricrity 4 Pricrity 9
Pricrity & Sending FILLFILE. T#=T: 1 of 1
FILLFILE. T=T

The main screen shows the status of each queue. WxReTran operates continuously sending
received weather messages. In the event that no messages are available, the filler file,
FillFile.txt, will be sent.

If your transmitting speed is slower than 9600 baud, you should use caution when selecting files
for retransmission. At 1200 baud, you can only send a fraction of the files that are being
transmitted by NOAA. The system log file, RtLog.txt, or Queue Status screen can be reviewed to
determine if you are overloading your system.

Every six hours, the system writes statistics about program operation. These statistics will let
you know how many files have been sent, the number of filler files that have been sent and the
maximum number of files that had to wait in each queue. These statistics are reset at midnight.

The log file may also contain other messages. An entry will be made in the log file each time a
message is overwritten. In addition, any files that have not been transmitted before the user
specified purge-time, will be recorded.

© 2010 Weather Message Software



WxReTran - Serial Port Retransmission 9

You should review the log file periodically to see if your system is overload. When the log file
reaches 100,000 bytes, it is copied to RtLog.old and a new log file is created.

Messages that are received for processing are listed in their respective priority queue on the
screen. If you want to remove a file from the current queue, select the file and press the delete
key. Note: You cannot remove a message that is currently being transmitted.
Note: If WxReTran is stopped with the window minimized, the next time it is started, it will start
minimized.

2.2  Menu Options

. EMWIN ReTransmission Engine - By Weather Message

File  Help

Sending  FILLFILE. TT Block 1 ©of 1 Filez Sent;
Tranzmitting 1200 BFS Compreszion Fatio = 1:1 Throughput = 1200 BFS

The menu buttons on this screen perform these functions:

The File menu allows you to export and import the program registry values, print the alarm and
group settings and exit the program.

Setup

Send Marse 1D
Wieww LogFile
Show Ingesk

Queue Stakus

Export Setkings
Impoart Settings

Exit

The Setup option displays the setup window.

The Send Morse ID causes the program to send morse code identification to the modem.

The View Logfile displays the log file in notepad.

The Show Ingest option shows the main window of each ingest program running the

background.

The Queue Status option displays the gueue status window.

e The Export Settings option will export all of the registry settings for the Weather Message
programs. They are exported to WxRegSet.txt. This allows a user to easily backup the
weather message directory and save all of their settings.

e The Import Settings option will import the registry settings contained in the WxRegSet.txt

file.

© 2010 Weather Message Software
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e The Exit option exits the program.

The Help menu allows you to see this manual, and display information about the program.

Weather Message Help
About

Weather Message on the Web

E-Mail Program Suppork

2.3  Setup
2.3.1 System Tab

The System Tab is used to setup general program operating information.

]

Setup
File

Friority 4 | Pricrity 5 || Priority 6 | Pricrity 7 | Pricrity 8 || Priority 3 | Priorite 10
System | Compress | Digcard | Copies | Schedule | Morse | Port Pricrity 1 || Priarity 2 | Pricrity 3

Ingest Path C:hwEmesgnetsmsdatatrefiles2
Ingest Engine Senal Ingest ] Internet ngest Software Demod O
WeatherWwire [ MoasPart Ll
UrZip Received Files ] Show in Tazk Bar
Enable Byte Blaster Server Support Fi Auta Startup Ma "
Furge directonies after 25 | hours.
If all mezzages have been sent, zend C: et esgMetvFillFile, bt

by inserting it into: | C:\wsmesgnethwixD ata\ Pl O8FillFile. bt

Log file zize 100000

Lag Sent Blocks [] Daily Log Files Shaow Errars

Ingest Path — The directory that will contain the received files to be processed by WxRetran.

Ingest Engine — Select Serial Ingest for the serial port engine, Internet Ingest for the Internet
engine, Software Demodulator for the software demodulator engine, Weather Wire for the
weather wire engine, or NOAAPORT for the NOAAPORT engine.

© 2010 Weather Message Software
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UnZip Received Files — Check this box if you want compressed files to be unzipped before they
are processed by WxRetran.

Enable Byte Blaster Server Support — Check this box if you want WxReTran to send data to
WxBBSrvr (byte blaster server) for processing. (This allows for an Internet backup of your
retransmission data.)

The Show in Task Bar option, when checked, will move the program from the system tray to the
task bar.

The Auto Startup option allows you to specify whether WxReTran is automatically started when
Windows starts. The options are No; Yes, for the current user; and Everyone, for any user.

Note: The options available for Auto Startup are based on your user permissions.
Administrator and Power users will have all of the options. Other users may only have the Yes
option.

Purge directories after — Enter the amount of time, in hours, that the system should purge the
directories used by the retransmission program. Note: Messages that have been queued, but
not sent, will be purged after this amount of time.

If all message have been sent, send — Enter the name of the file to be sent when WxReTran
does not have any weather messages to sent. The system defaults to "FillFile.txt". The file is
located in the WxMesg directory and can be edited to contain your local information.

Insert into — Enter the priority directory name and file name that this file should be copied. The
filler file is normally copied to the \WxMesg\WxData\RtPri10 directory. Remember to put the file
name on the destination path.

Log File Size — Enter the log file size in bytes.

Log Sent Blocks — Check this box to log all of the weather messages sent and the times that the
morse identification is sent.

Daily Log File — Check this box to store log files for each day in the ..\WxMesg\WxLogs
directory. The logs for each day are copied to this directory. The log file name is appended with
the day number. These logs will be overwritten with the next month's logs. After enabling this
option, you must restart all Weather Message programs.

Note: Enabling this option disables the log file size option.

Show Errors — Check this box to have the program pop-up error conditions as they occur.
Regardless of this setting, the program will write all errors to the log file.

2.3.2 Compress Tab

The Compress Tab is used to specify a group of files that should be compressed as a group before
being transmitted.

© 2010 Weather Message Software
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2.3.3

Setup
File

Friority 4 || Prionty 5 | Priority & | Prionty 7| Priority 8 || Prionky 9| Prioritg 10
System | Compress | Discard | Copies | Schedule | Morse | Paort Friority 1 || Pricrity 2 | Priority 3

To add an itemn

Type it here -

Then Press Enter

To remove ar item Click the iter here -

Then click herg -

Awaiting Compreszion

Send block compressed files priorty = 10

Do block comprezsion when files accumulated = 20

To add items to the compress queue, enter the weather message file name in the Type it here
box and press enter. The file name will appear in the list box. You can use the wild card
character ? to match any character in the received file name. The program requires that you
enter at least two alpha characters.

The Send block compressed files priority field is used to enter the priority queue that will be
used to send the files after they are compressed.

The Do block compression when files accumulated = is used to enter the number of files that

should be received before compressing the files for transmission.

Discard Tab

The Discard Tab is used to enter the file names for messages that you do not want sent.

© 2010 Weather Message Software
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Setup
File

Priority 4 || Pricrity 5 | Priority & | Priority 7 || Pricritg 8 || Pricrity 3 | Priority 10
System I:l:umpress| Dizcard |I:|:||:|ies Schedule | Morze | Port Friority 1 || Pricrity 2 | Priority 3

To add an itemn

Type it here -

Then Press Enter

To remove ar item

Click the item here --»

Then click here --»

By default, WxReTran will discard all files that do not match any of the priority or compression
queues. You however, can use this tab to catch specific files before they are processed by th
priority or compression queues.

2.3.4 Copies Tab

The Copies Tab is used to setup message files that are to be transmitted more than once.

e

© 2010 Weather Message Software
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satup ]
File

Priority 4 | Prionty 5 | Prionty & || Priorty 7| Priorty 8 | Priarity 3 || Prionkg 10
Syztem || Compress Discardl Copiez | Schedule | Morse || Port Priority 1 | Priority 2 | Pricrity 3

I1ze thiz tab to force meszages to be sent more than once.

To add an item

Select The Mumber Of Copies - IT

Enter & Kepward ---» |

Then Press Enter

To remove an item

Click. the item here -

Then click here -

If you want to send a weather message more than once, enter the number of copies in the Select
The Number of Copies field. Enter the file name in the Enter a Keyword field and press enter.
When the entered file name is received, it will be duplicated the number of times you specify.
You can duplicate a file up to 9 times.

2.3.5 Schedule Tab

The Schedule Tab is used to automatically insert an external message file into a priority queue.

© 2010 Weather Message Software
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Setup
File

Friority 4 || Prionty 5 | Priority & | Prionty 7 || Priority 3 || Prionky 9| Prioritg 10
System | Compress | Discard I:l:upiesl Schedule | Morse | Paort Friority 1 || Pricrity 2 | Priority 3

Type a zchedule entry here, then press "Enter"

Mare Information ] ||

Example:
1300 vt ezghFillFile tet o Wbl wbdesghhafwD atah B HPHESFillFile. bat

Scheduled Tranzmizsions

Toremove an entry:

Click the enty here -

Then press "Delete’ or
chck "Remove"

Remove

Using the example provided on the screen, enter the time that the message should be sent, in
military time format. Followed by a space, then the source path and file name, followed by a
space and the priority queue path and file name. After entering the schedule, press enter to
place it in the scheduled transmissions list.

To delete multiple items from the list, select all of the items to be deleted and press the delete
key.

2.3.6 Morse Tab

The Morse Tab is used to setup your morse code call sign (identification).

© 2010 Weather Message Software
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X

Setup
File

Priority 4 | Prionty 5 | Prionty & || Prionty 7| Priorty 8 | Priarity 3 || Priontg 10
System || Compress | Discard || Copies | Schedule | Morse | Port Friority 1 | Priority 2 | Pricrity 3

Marse |dentity DE EMWIN TEST

|0 Frequency 10 | Minutes

Time To Mext (D 3 hinutes
Timne OF Last 1D
|dentifier Speed Factar el

Morse ldentify — Enter your FCC issued call sign. If you don't require identification, leave this
field blank.

ID Frequency — Enter the length of time you are required to send your call sign. This normally is
15 minutes for a business band frequency or 30 minutes for public safety. If you are in-doubt,
check with your local two-radio dealer.

Identifier Speed — This field is the morse code speed factor. The default of 25 results in 20
word-per-minute morse code. You can increase or decrease this factor to change the speed.

2.3.7 Port Tab

The Port Tab is used to setup the comm port that is attached to your radio modem.

© 2010 Weather Message Software
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Setup

File

Friority 4 || Priority 5 | Priority & | Prionty 7| Priority 3 || Prionky 9 | Prioritg 10
System || Compress | Discard | Copies | Schedule | Morse | Port Friority 1 || Pricrity 2 | Priority 3

Tranzmitter Delay o0 | milizeconds

Fart 3

Tranzmit far q minutes, pause for
Diata Rate 1200 10 zeconds, then resume transmitting.
Drata Bits g
Stop Bitz 2
Parity i

Com Port # 3 opened for tranzmit,

Port — Click on the port field to change the comm port. Selecting Port O (zero) will disable the
sending of data through the comm port.

Note: Selecting Port O (zero) may be desirable if you will only be using WxRetran to feed a
private byte blaster server.

Data Rate — Click on the data rate field to change the data rate.

The Data Bits, Stop Bits and Parity cannot be changed with the setup program. If you need a
different configuration, send an email to help@wxmesg.com

Transmitter Delay — Enter the time, in milliseconds, required to key up your transmitter.

Transmit For — These fields are used when you don't have a continuous duty transmitter. You
can specify the number of minutes to transmit and the number of seconds to pause the
transmitter. If you have a continuous duty transmitter, sent the "Transmit For" field to 0 (zero).
See Appendix B for information on continuous duty.

2.3.8 Priority Tab

There are 10 Priority Tabs. The highest priority is 1 and the lowest 10. Each Tab operates the
same. You will need to determine the priority of the weather messages that you intend to
retransmit.

For example, Tornado Warnings, Severe Thunderstorm Warning, Flood Warnings, etc. are
normally assigned to Priority 1. Watch products can be assigned to Priority 2. You can use the

© 2010 Weather Message Software
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remaining priority queues for other weather products. Graphic files can be assigned to the lowest
Priority 10.

File

Friority 4 || Priority 5 | Priority & | Priorite ¥ || Priority 3 || Priority 9 | Priorite 10
System | Compress | Dizcard | Copies || Schedule || Marze | Port Fricrity 1| Priority 2 | Priority 3

To add an itemn

Type it here - |

Then Preszs Enter

Toremove at item

Click the item here -

Then click herg > R emove

Ovwenwrite Pending Files
[] Send Files Compregzed

To add items to this priority queue, enter the weather message file name in the Type it here box
and press enter. The file name will appear in the list box. You can use the wild card character ?
to match any single character in the received file name. The wild card character * can be used to
match multiple characters in the received file name. The program requires that you enter at least
two alpha characters.

Priority tab 3. To send all weather roundups for Alabama priority 2, add RWR???AL.TXT to the
list on Priority tab 2. To send tornado warnings for Alabama Priority 1, add TOR???AL.TXT to
the list on Priority tab 1.

following your text products.

To remove a file from the list, click on the item and the click on the Remove button. The file will
be remove from the list and will no longer be processed.

The Overwrite Pending Files option, if checked, tells the program to overwrite a pending file
with a newer file, of the same name. This option can be used with a priority queue that will
process graphics files. If a graphics file is waiting to be sent and a newer file arrives, the older
file will be overwritten by the newer file. Note: This option should not be used with weather text
files. It can cause messages with the same name to be overwritten, even though the message
may contain different weather text.

The Send Files Compressed option allows you to specify if you want the files received in this

© 2010 Weather Message Software
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queue to be compressed before they are sent. Note: Compression of single files does not
usually result in a lot of savings for some file formats. The Compress tab can be used to
compress a group of files, which normally results in more savings.

2.4  Adding Local Data

Local data can be inserted into the retransmitted data stream. To insert your own products, copy
the file to one of the priority directories. They are named C:\WxMesgNet\RtPril through

C:\WxMesgNet\RtPri10.

If is recommended that you follow the NOAA file naming convention. A product file name should
be in 8.3 format. That is 8 characters before the period and 3 characters afterwards. The
extension for weather text files should be TXT. For graphic products, use the appropriate

extension.

WxRadar can be used to include radar images. You can also use WxLocal to include local
weather conditions. (For information on WxLocal, see the Weather Message website.)

2.5 Queue Status

The WxReTran Status window shows the status of each priority queue.

WxReTran Status

[Jueue Statuz
[ueue
1

LA m N Rt N e B S R T D |

—
O

Pending
1]

— o O O o O O O] O

%]

b asirnurn Y iting
1]

— o O O o O O O] O

Cloze

The Pending column shows the number of files that are currently pending. The Maximum Waiting
column shows the maximum number of files that have been waiting at one time.

© 2010 Weather Message Software









22 Weather Message - EMWIN Retransmission

3 WxBBSrvr - Byte Blaster Server

3.1 Overview

WxBBSrvr is used to retransmit EMWIN data over the Internet or a private network. A computer
retransmitting data over the Internet is referred to as a Byte Blaster Server. The EMWIN data
network is designed to allow anyone to run a server. All that is required is available bandwidth.

e ByteBlaster, Server - by Weather, Message ["_”E”zl
File  Help
Server Address E7.47.220.78 Puort 1000
Alloved Clients 10 Semver Type Frivate
Status Receiving data from "W=lingest Engine Drata Quality 100%
Cligntz 0 [rata Rate 0 kbps Pending D ata 1
Serving FPFMGIDME.ZIS - Block 1 of 4

The main server window shows the servers activity.

In order for WxBBSrvr to receive data from the ingest engines, you must go into the setup screen
on one of the ingest engines and check the Enable Byte Blaster Server Support. If you decide
to not use the Byte Blaster server, you should uncheck this box.

WxBBSrvr uses TCP/IP port 999, 1000, 1001 and UDP port 9510 to communicate with the NOAA
Host Master, Byte Blaster clients and the local ingest programs. If you have a firewall, port 1000
and 1001 must be open for WxBBSrvr to work.

Note: If you want to use WxBBSrvr to retransmit data on a private network, send an email to
help@wxmesg.com for information to enable this operation. The default configuration requires
access to the NOAA host master for proper operation.

Note: WxBBSrvr can receive data from the retransmission software WxReTran. This can be
useful if you want to provide a backup for your local retransmission system. If you want to use

this option, enable "Byte Blaster Support" in the retransmission software. Using this option will
make your server a private EMWIN server.

Note: If WxBBSrvr is stopped with the window minimized, the next time it is started, it will start
minimized.

System Tray
When WxBBSrvr is minimized, you can restore the main screen by right clicking on the system

tray icon , then select open.

Copyright © 2010 Weather Message Software
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3.2  Operation

WxBBSrvr waits for byte blaster client connections. After a client connects to the server, the
client is required to identify itself at the time the connection is established and once every 12
minutes. If a client does not identify itself within the allotted amount of time, the byte blaster
client is disconnected. Once the connection is established, the server begins to send the byte
blaster client data.

The server maintains a 64K buffer for each connection. If a client's buffer reaches this maximum,
the server will disconnect the client. A full client buffer indicates that the client is not capable of
receiving data fast enough. This could be due to Internet congestion or other problems related to
the Internet.

Should the server receive more connections than are allowed, the server will send the byte
blaster client a list of the current byte blaster servers and disconnect. This will allow the
disconnected byte blaster client to locate an available byte blaster server.

The server is in constant communication with the NWS host master. The host master maintains
a list of private and public byte blaster servers. Every 15 seconds, the byte blaster server reports
the number of connections and status of the server to the host master.

The host master sends a list of public servers to each byte blaster server every 10 minutes. This
server list is passed along to each connected byte blaster client. This capability allows all of the
byte blaster clients to have a current list of available byte blaster servers. It also allows the byte
blaster network to be dynamically configured.

Every six minutes, the server requests its IP address from the host master. This serves as a
keep-alive packet for the connection to the host master. It also serves to update the host master
should a server's IP address change dynamically.

A connection to the host master is required for proper operation. Provisions have been made to
run the server on a private network where an outside connection to the host master is not
available. Contact Weather Message for setup details.

The server receives data from WxXEmwin (serial port, software demodulator, and internet) or
WxReTran (retransmission). The ingest programs broadcast their received data packets on the
TCP/IP loop back. WxBBSrvr listens for this data on UDP port 9510. WXEmwin sends an error
percentage to the byte blaster server. If the receive quality drops below 95 percent, the server
will stop sending data to the byte blaster clients.

Note: If you use WXxEmwin to supply data to WxBBSrvr, WxEmwin will only connect to servers
listed in the WxSatus.txt file. This file is not automatically updated by the byte blaster system.
Although provisions were made to keep this server list updated, they were never implemented

in the NWS host master software. At the present time, this file contains a list of known servers
at EMWIN headquarters.

3.3 Setup

The setup window allows you to establish information about your server.

Settings Tab
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WxBBSrvr Setup

Seftings | Options

Public EMWIH Server

Server Location “Weather Meszage Met Version
M awirmurn U zers 10
TCPAP Part 1000

Usze Fived Address Fi
Fiwed TCP/P Address

Feparting Baud

Save l | Cancel

Public EMWIN Server - If checked, will allow any EMWIN user can access your server. Your
server's address will be published to all byte blaster clients for public use. Uncheck this box if
your server is for private use. In this case, your address will not be published for public use.

Note: If the Reporting Baud is 1200 or 2400, the NWS Host Master will not publish this server
on the public network.

Note: If the program receives data from the retransmission software, it will automatically
switch to a private server.

Enter location for your server in the Server Location field. For example, "Weather Message
Server 1 — Dadeville, AL".

Enter the number of users/clients that can connect to your server in the Maximum Users field.
This number can range from 1 to 900. Take your available Internet bandwidth into consideration
when you set the number of users. Each connection will use approximately 19,200 kbs.

Enter the TCP/IP Port for your server. The default port is 1000. If this is not available use the
IANA assigned EMWIN port 2211.

The program will automatically determine its TCP/IP address. In some cases, this address may
not be correct because of a firewall or other settings. To specify an IP address for this server,
check the Use Fixed URL box and enter your IP address in the Enter Fixed URL box.

The Reporting Baud displays the baud rate that will be reported to the NWS Host Master. Valid
values are blank, 1200, 2400 and 9600. A blank entry is reported as 9600. Only 9600 baud
servers can participate in the public EMWIN network.

Note: The Reporting Baud is determined by the baud rate setting in WXEmwin. Baud rates
higher than 9600 baud are reported as 9600 baud. You can override this setting by adding a
registry entry. Contact Weather Message for details.
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Options Tab

WxBBSrvr Setup

Seftings | Optionz

Log File Size 100000
Doaily Log Files

Liog Achivity

Show Errars

Auto Startup Mo W

I Save l l Cancel

The Log File Size field allows you to specify this size of your ingest log file, BBLog.txt. The
default is 50,000 bytes.

The Daily Log Files option, when checked, causes the program to store the log files for each
day in the .\WxMesgNet\WxLogs directory. The logs for each day are copied to this directory.
The log file name is appended with the day number. These logs will be overwritten with the next
month's logs. After enabling this option, you must restart all Weather Message programs.

Note: Enabling the Daily Logs option disables the log file size option.
Check the Log Activity box to have the program log connects and disconnects to the log file.

Check the Show Errors box to have the program pop-up error conditions as they occur.
Regardless of this setting, the program will write all errors to the log file.

The Auto Startup option allows you to specify whether WxBBSrvr is automatically started when
Windows starts. The options are No; Yes, for the current user; and Everyone, for any user.

Note: The options available for Auto Startup are based on your user permissions.
Administrator and Power users will have all of the options. Other users may only have the Yes
option.

34 Server Status

You can see the status of the EMWIN Byte Blaster network by clicking on Help and selecting
Server Status. The following window is displayed.
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i Server - Status

Host baster: On-Line
Current Server List Current Sat Server List

£8.94.190.61:1000 A
£3.1058.45.6:1000
140.90.123.133:1000
207.210.204.29:1000
7432721181000
140.90.123.132:1000
216.245.137.10:1000
140.90.5. 2451000 o

Cloze

The Current Server List box lists the servers that are currently available for byte blaster client
connections. The EMWIN Host Master maintains this list and updates each server automatically.
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4 WxEmwin - EMWIN Ingest

4.1 Overview

WxEmwin is used by Weather Message to receive EMWIN data. EMWIN data can be received
from a serial port, software demodulator or Internet. The ingest program can be started
automatically by the Weather Message Server or manually.

% WxEmwin - EMWIN Ingest Engine M=E3
File  Help
senial Ingest | Software Demodulator || Internet Ingest
Froceszing File Block File Size
FusSHFLFL. TiRT 2of 5 5120
[ ]
Part Comb Packet Length 1
Total Blocks G0 Bad Header 0
Bad Blocks 1 Check Sum 0
Erar Percent 17 Elock Count 1
FMUS72 KMFL 241403 -~
FuSMFL
SPOT FORECAST FOR BILLIE S'wiAkP SAFARI
MATIOMNAL WEATHER SERVICE klakI FL =
Skarking Purge Cycle .,

The main screen may contain up to three tabs that show the status of the serial, software
demodulator and internet ingest subsystems.

The status bar at the bottom of the window contains status message indicating the operation of

the application. Should the program stop receiving data, you will see a red Data Alert message
indicating the data failure.

Note: If WXxEmwin is stopped with the window minimized, the next time it is started, it will start
minimized.
Note: You can have one or more ingest engines running at the same time. It is common to
have both the Serial Ingest and Internet Ingest running at the same time for dual ingesting of
EMWIN data.

System Tray

When WxEmwin is minimized, you can restore the main screen by right clicking on the system
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tray icon , then select open.

Data Alert Notification

29

Should the program stop receiving data, you will see a notification message above the system

tray icon. This message will indicate the data stream that has failed.

i\, WHxEmwin Status |

Mak receiving Serial data.

Copyright © 2010 Weather Message Software

4.2  Menu Options

= WxEmwin - EMWIN Ingest Engine |Z||E|[Z|

File  Port  Demodulator  Conmect Help

senial Ingest | Software Demodulator || Internet Ingest

The menu buttons on this screen perform these functions:

Note: The Port menu option only appears when the Serial Ingest tab is selected. The

Demodulator menu option only appears when the Software Demodulator tab is selected. The

Connect menu option only appears when the Internet Ingest tab is selected.

The File menu allows you to setup this program, view logfiles, and exit the program.
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Setup
Reset Stats

Wigw Main Logfile

Wiew Serial Log

View Serial Files Received

Wiew Demodulakar Log
Wiews Demodulator Files Received

View Demaodulakar Statistics

View Internet Log

Wiews Internet Files Received

Exxit

The Setup option opens the Setup window.

The View Main Logfile displays the main log file, WelLog.txt, in notepad.

The View Serial Log displays the serial ingest log file, WsLog.txt, in notepad.

The View Serial Files Received displays the received files log, WsFiles.txt, in notepad.

The View Demodulator Log displays the serial ingest log file, WdLog.txt, in notepad.

The View Demodulator Files Received displays the received files log, WdFiles.txt, in

notepad.

e The View Demodulator Statistics displays the demodulator statistics log, WdStatus.txt,
in notepad.

e The View Internet Log displays the serial ingest log file, WiLog.txt, in notepad.

e The View Internet Files Received displays the received files log, WiFiles.txt, in notepad.

e The Exit option shuts down WxEmwin.

Note: In order to view the Files Received Log, the Log Received Files option must be
enabled.

The Port menu, when present, allows you to switch between the main serial port and a backup
serial port.

The Demodulator menu, when present allows you to interact with the EMWIN Software
Demodulator provided by the National Weather Service.

Demodulator Skatus
Skop Data Source Service
Stop Demodulator Service

Launch Conkral Panel

e The Demodulator Status opens the software demodulator status window.
e The Stop Data Source Service or Start Data Source Service option stops or starts the
software demodulator data source service.

e The Stop Demodulator Service or Start Demodulator Service option stops or starts the
software demodulator data source service.

e The Launch Control Panel option launches the software demodulator control panel.
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Note: When using the EMWIN Software Demodulator, both the EMWIN Data Source and
Demodulator service must be running.

Note: The Demodulator Status screen requires the Weather Message Demodulator service
to be installed. The Demodulator service distributed by the National Weather Service does
not output statistics.

The Connect or Disconnect menu, when present allows you to force the Internet Ingest engine
to disconnect and connect to the next available Internet EMWIN server.

The Help menu allows you to see this manual, and display information about the program.

Weather Message Help
About

Weather Message on the Web
E-Mail Program Support

4.3  Serial Ingest Tab

The Serial Ingest tab, when visible, shows the option of the serial ingest engine.

senal Ingest | Software Demodulator || Internet Ingest

Froceszing File Block File Size

CGRSFOCA.TxT 2of 2 2048
[ ]
Part Comb Packet Length 1
Total Blocks 1254 Bad Header n
Bad Blocks 1 Check Sum 0
Erar Percent 0 Elock Count i
SxUSEE KMTR 241509 -
OMRDAR
TIME PTREYES BODEGA GG EBRIDGE PIGEOH PT
ANGEL 15

L

The Processing File, Block and File Size fields show information about the received file. A
or red led appears to the right of the Processing File field. This led will normally appear
green. If any of the blocks received for this message are defective, the led will change to red.

To monitor the received blocks, click on the or red led. The following window will appear
displaying the received blocks.
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L_ |

Received Blocks
IIIIII==IIIIIIIIIIII

The Port field displays the serial port that is receiving the data. If you have a second receiver,
you can switch to the backup port by clicking on the Port menu option.

The Total Blocks field shows the total number of blocks received for a one-hour period, the Bad

Blocks field shows how many of the total blocks received were defective. The bad blocks field is
a total of the Packet Length, Bad Header and Check Sum fields. The Block Count field counts
the number of messages that any blocks missing.

The Error Percent field shows the error percentage of the blocks received verses bad blocks.
You want this field as low as possible. The background color of this field will change based on
the quality of the received data. If the background is white, the received data has 10% or fewer
errors. If the background is yellow, the received data has between 10% and 20% errors. If the
background is red, the received data has an error rate greater than 20%.

If the received message is text, you will see the first 1024 characters of the message in the text
box. This shows the text for the block just received, it does not show the complete message.

The ingest program will attempt to repair defective messages, if a duplicate message is sent
through the EMWIN data stream.

WxEmwin Serial Ingest supports a backup satellite system, retransmission receiver and/or
backup by Internet. This option is enabled on the Setup Serial Ingest Tab.

Should the Serial Ingest engine stop receiving data, the status bar will display a message in red
indicating that data has stopped. A natification icon will also appear in the system try. A text
message is generated and placed in the ingest directory for processing by Weather Message.
You can alarm the product ADMWXM to receive notifications of data loss.

Note: It is recommended that you run the ingest program on a computer that will not be used
for normal user programs. The processing of serial data can be interrupted by other software
programs, which can result in lost weather products.

Note: While the program is using Internet Ingest as a backup data source, the fields on the
screen may not be updated. They will resume showing data when the main serial port begins
to receive data.

Note: The program supports a second log file. The second format uses a fixed field size for
easy analysis. This log file is never purged and remains until the user deletes the log files. To
enable this logging option, create the directory "NwsLogs" in the c:\program files\WxMesgNet
directory.

Note: Some computers may detect your satellite receiver as a serial mouse. This generally
occurs when the satellite receiver is turned on when booting the computer. If this occurs, your
mouse will begin to move on it's own. To correct this problem, turn off the satellite receiver.
Download the comdisable tool from Microsoft at this web address
http://support.microsoft.com/default.aspx?scid=kb;en-us;819036.
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4.4 Software Demodulator Tab

The Software Demodulator tab, when visible, shows the option of the Software Demodulator
ingest engine.

Serial Ingest | Software Demodulatar | |nternet |ngest

Processing File Block, File Size
]
[ ]
Total Blocks Packet Length
Bad Blocks Bad Header
Ermor Percent Check Sum
Block Count

The Processing File, Block and File Size fields show information about the received file. A
or red led appears to the right of the Processing File field. This led will normally appear
green. If any of the blocks received for this message are defective, the led will change to red.

Note: In order to process data, the EMWIN Data Source service and EMWIN Demodulator
service must be running. Use the Demodulator menu to start and stop these services.

To monitor the received blocks, click on the orred led. The following window will appear
displaying the received blocks.

1= |

=1

Received Blocks
LT

The Total Blocks field shows the total number of blocks received for a one-hour period, the Bad

Blocks field shows how many of the total blocks received were defective. The bad blocks field is
a total of the Packet Length, Bad Header and Check Sum fields. The Block Count field counts
the number of messages that any blocks missing.

The Error Percent field shows the error percentage of the blocks received verses bad blocks.
You want this field as low as possible. The background color of this field will change based on
the quality of the received data. If the background is white, the received data has 10% or fewer
errors. If the background is yellow, the received data has between 10% and 20% errors. If the
background is red, the received data has an error rate greater than 20%.
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If the received message is text, you will see the first 1024 characters of the message in the text
box. This shows the text for the block just received, it does not show the complete message.

The ingest program will attempt to repair defective messages, if a duplicate message is sent
through the EMWIN data stream.

WxEmwin Software Demodulator ingest supports a backup satellite system, retransmission
receiver and/or backup by Internet. This option is enabled on the Setup Software Demod Tab.

Should the Software Demodulator ingest engine stop receiving data, the status bar will display a
message in red indicating that data has stopped. A notification icon will also appear in the
system try. A text message is generated and placed in the ingest directory for processing by
Weather Message. You can alarm the product ADMWXM to receive notifications of data loss.

Note: It is recommended that you run the ingest program on a computer that will not be used
for normal user programs. The software demodulator requires a large percentage of your
computer processor in order to decode the data. This process can be interrupted by other
software programs, which can result in lost weather products.

Note: While the program is using Internet Ingest as a backup data source, the fields on the
screen may not be updated. They will resume showing data when the main serial port begins
to receive data.

Note: The program supports a second log file. The second format uses a fixed field size for
easy analysis. This log file is never purged and remains until the user deletes the log files. To
enable this logging option, create the directory "NwsLogs" in the c:\program files\WxMesgNet
directory.

441 Software Demodulator Status

The Software Demodulator Status screen can be displayed by opening the Demodulator menu
option and clicking on Demodulator Status. This window displays status information from the
software demodulator.
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Software Demodulator Status x|

— GPSE Recerver

Dats Source Status IIStarteu:I— Side Lobe Detected IND—
Camier Frequency IW Syrnbol Track Freq W
Carmier Track W Duration IW
Spmbol Track W Input Signal Lewvel IW
Front End Signal W E stimated EbMo IW

— Bit Processar

Cosds Frames Seen I?dEIEI— Yiterb Bitz Decoded W
Cradz Fill Frames ErL! Witerbi Sunc Errars I'I—
IIncormectable Errors |25— Yiterbl Sumbol Errors IW
Comectable Errors 164 Witerbi Average Esto IW

Note: The Demodulator Status screen requires the Weather Message Demodulator service to
be installed. The Demodulator service distributed by the National Weather Service does not
output statistics.

Depending on the EMWIN signal being decoded, the first group will display FSK Receiver or
QPSK Receiver. When the FSK Receiver is being used, the Bit Processor will not display any
data.

The following information is a brief and non-technical explanation of the fields.
QPSK / FSK Receiver

Data Source Status - Display the state of the software demodulator. These status messages
may appear: Not Configured, Not Connected, Connected, Opened, Started, Retry, Unknown.
The operating status is Started.

Carrier Frequency - Displays the current frequency being tracked by the software demodulator.
This value will normally be zero, however, it may appear as plus or minus numbers based on
your receiver hardware.

Carrier Track - Displays the state of the internal carrier tracking software. These status
messages may appear: Acquire, Verify, False Lock, Tracking, Unknown.
The operating status is Tracking.

Symbol Track - Displays the state of the internal symbol tracking software. These status
messages may appear: Acquire, Verify, False Lock, Tracking, Unknown.
The operating status is Tracking.

Front End Signal - Indicates whether the software demodulator has detected a signal. This
field will display Present or Absent. The operating status is Present.

Side Lobe Detected - Indicates whether a side lobe has been detected. The operating status is
No.
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Symbol Track Frequency - Displays the current symbol frequency being tracked by the
software demodulator. This value will vary between the limits entered in the Software
Demodulator Control Panel.

Duration - Displays the time, in seconds, that the software demodulator has been running.
Input Signal Level - Displays the internal received signal level.

Estimated EbNo - For QPSK, displays the estimated energy per bit to noise power spectral
density ratio. It is a normalized signal to noise ratio.

Low / High Signal - For FSK, indicates whether the low and high signals are present.
Bit Processor

CCSDS Frames Seen - Displays the number of received packets. CCSDS formatted packets
represents a standard established by the Consultative Committee for Space Data Systems.

CCSDS Fill Frames - Displays the number of received packets that do not contain any data.

Uncorrectable Errors - Displays the number of received packets that could not be corrected.
This number should remain zero or close to zero. Numbers here indicated lost packets.

Correctable Errors - Displays the number of received packets that could be corrected.

Viterbi Bits Decoded - Displays the number of viterbi bits decoded. The QPSK receiver uses a
viterbi decoder. A viterbi decoder uses the Viterbi algorithm for decoding a bitstream that has
been encoded using Forward error correction based on a Convolutional code.

Viterbi Sync Errors - Displays the number of viterbi synchronization errors.

Viterbi Symbol Errors - Displays the number of viterbi symbols errors.

Viterbi Average EsNo - Displays the average energy per symbol to noise power spectral
density.

4.5 Internet Ingest Tab

The Internet Ingest tab, when visible, shows the option of the Internet ingest engine.
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Seral Ingest | Software Demodulator | [ntemet lngest

Proceszing File Black, File Size

WSWFSDSDLT=T @ 1of3 2072
| |
Server 136.145.85.20 Connect Time 0:01:08
Total Blocks 43 Bad Header 0
BadBlocks 1] Check Sum 1]
Erar Percent 0o Block Count 1
WhALISA3 KFSD 241553 A
WSWESD

URGEMT -wINTER WEATHER MESSAGE
NATIOMAL WEATHER SERYICE SIOLUE FALLS SD

Internet Ingest uses information from EMWIN Byte Blaster Servers to maintain a list of available
servers. It attempts to connect to the first available server. Should a server stop functioning, the
Internet Ingest engine will attempt to contact the next available server. Every 10 minutes the
internal list of servers are updated.

Internet Ingest uses TCP/IP port 1000 to communication with the servers. If you have a firewall,
port 1000 must be open for outbound connections.

The Processing File, Block and File Size fields show information about the received file. A
or red led appears to the right of the Processing File field. This led will normally appear
green. If any of the blocks received for this message are defective, the led will change to red.

To monitor the received blocks, click on the orred led. The following window will appear
displaying the received blocks.

x|

Received Blocks

The Server field displays the address of the current Byte Blaster Server in use. You can force
the program to connect to the next available server by clicking on the Disconnect or Connect
menu option.

The Total Blocks field shows the total number of blocks received for a one-hour period, the Bad

Blocks field shows how many of the total blocks received were defective. The bad blocks field is
a total of the Packet Length, Bad Header and Check Sum fields. The Block Count field counts
the number of messages that any blocks missing.

The Error Percent field shows the error percentage of the blocks received verses bad blocks.
You want this field as low as possible. The background color of this field will change based on
the quality of the received data. If the background is white, the received data has 10% or fewer
errors. If the background is yellow, the received data has between 10% and 20% errors. If the
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background is red, the received data has an error rate greater than 20%.

If the received message is text, you will see the first 1024 characters of the message in the text
box. This shows the text for the block just received, it does not show the complete message.

The ingest program will attempt to repair defective messages, if a duplicate message is sent
through the EMWIN data stream.

WxEmwin Internet Ingest supports backup with the Weather Wire Ingest program. This option is
enabled on the Setup Internet Ingest Tab.

Note: To use Weather Wire Ingest as a backup, you must have an active subscription for
Weather Wire and have purchased a license from Weather Message for that ingest engine.

Should the Internet Ingest engine stop receiving data, the status bar will display a message in red
indicating that data has stopped. A notification icon will also appear in the system try. A text
message is generated and placed in the ingest directory for processing by Weather Message.
You can alarm the product ADMWXM to receive notifications of data loss.

Note: While the program is using Weather Wire Ingest as a backup data source, the fields on
the screen may not be updated. They will resume showing data when a Byte Blaster Server
begins to send data.

Note: The program supports a second log file. The second format uses a fixed field size for
easy analysis. This log file is never purged and remains until the user deletes the log files. To

enable this logging option, create the directory "NwsLogs" in the c:\program files\WxMesgNet
directory.

4.6  Setup
4.6.1 Serial Ingest Tab

The Serial Ingest Tab is used to define the communication port, backup options and other
general operations.
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Serial Ingest | Software Demad || Intemet Ingest | Comman || Ingest Paths

Enabled Eackup Options

Cornrn Port g =3
Cornm Port g w
Baud Rate SEOO0M BT Baud Hate SE00M.B +

Switch Back Time |0
Internet Backup
Error Rate Greater 10

Save ] l Cancel

The Enabled option should be checked if you want the Serial Ingest engine to automatically start
when WxXEmwin is started.

Primary Receiver

Select the Comm Port (communications port or serial port) for your satellite receiver, along with
the Baud Rate for that device. For EMWIN satellite reception, select a baud rate of 9600,N,8,1.

Secondary Receiver / Backup Options

If you have a second satellite system or retransmission receiver, enter the Comm Port and Baud
Rate under the backup options. Also, if you want to use Internet Ingest as a backup, check that
option. The Switch Back Time is used to specify the number of minutes that the program
should check back to see if the main port is functioning, when using a second serial port. If the
Switch Back Time is set to zero, the program will not attempt to switch back to the main port.

The Error Rate Greater field sets the error rate percentage for switch over to backup. This field
can be set from 5 to 95 percent. Should the error rate, of the received data, exceed the set
amount, the program will switch over to the backup port or Internet Ingest.

If the main port stops sending data for 15 seconds, the program will switch to the backup port, if
one is specified. If the backup port does not send data for 15 seconds, it will switch to Internet
Ingest, if Internet Backup is enabled. If the backup port is not specified, it will switch from the
main port directly to Internet Ingest.

Based on the Switch Back Time specified, it will change back over to the main port. The process
will start all over again. If no data is received in 15 seconds, it will switch to the backup port
and/or Internet Ingest.

Note: Once Internet Ingest is started, it will not be stopped until Serial Ingest begins to receive
valid data from one of the serial ports.

When the program switches from Serial Ingest to Internet Ingest, it will create a notification
message in each ingest directory. The product identifier for this message is ADMWXM. If you
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4.6.2

want to be alerted when the program switches between ingest sources, alarm the product
ADMWXM, with no state or county selected. The notification message contains the current
ingest method and computer name.

Note: This program communicates with WxBBSrvr using UDP port 9510 on the local loop back
address.

Software Demod Tab

The Serial Ingest Tab is used to define the communication port, backup options and other
general operations.

Serial Ingest | Software Demod | |ntemet Ingest | Common || Ingest Paths

Enabled Mot Installed,
Address 127.0.01
Port 18000

Internet Backup
Ermor Rate Greater |25
Log Demod Statz ]

[ Save ] | Cancel |

The Enabled option should be checked if you want the Software Demodulator Ingest engine to
automatically start when WxEmwin is started.

The Address field should contains the address of the software demodulator. The default setting
is 127.0.0.1. The Port field should contain the address of the EWMWIN Demodulator service.
The default port is 18000.

The Error Rate Greater field sets the error rate percentage for switch over to Internet Ingest
backup. This field can be set from 5 to 95 percent. Should the error rate, of the received data,
exceed the set amount, the program will switch over to Internet Ingest, if Internet Backup is
enabled.

If the software demodulator stops sending data for 8 seconds, the program will switch to Internet
Ingest, if Internet Backup is enabled.

Note: Once Internet Ingest is started, it will not be stopped until the Software Demodulator
Ingest begins to receive valid data.

When the program switches to Internet Ingest, it will create a notification message in each ingest
directory. The product identifier for this message is ADMWXM. If you want to be alerted when
the program switches between ingest sources, alarm the product ADMWXM, with no state or
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county selected. The notification message contains the current ingest method and computer
name.

The Log Demod Status, when checked, will cause the program to log the software demodulator
statistics every three seconds.

Note: This program communicates with WxBBSrvr using UDP port 9510 on the local loop back
address.

4.6.3 Internet Ingest Tab

The Serial Ingest Tab is used to define the communication port, backup options and other
general operations.

Serial Ingest | Software Demod | Intemet Ingest | Common | Ingest Paths
Enabled F
Auto-Reconnect on Server Disconnect Enable Werzion 2
Auto-Update Server List
‘weather ‘wire Backup
Use Fixed Address F]
Fied Server Addrezs 21624813714
Timeout [zeconds] on lozs of data 15
Save ] l Carizel

The Enabled option should be checked for the Internet Ingest engine to automatically start when
WxEmwin is started.

The Auto-Reconnect on Server Disconnect option, when checked, will cause the Internet
Ingest engine to try to connect to another server if it is disconnected from the current server.
This option is enabled by default and is the recommended setting.

The Auto-Update Server List option, when checked, will enable automatic maintenance of the
available internet servers. If Internet Ingest does not maintain this list, you will need to manually
update the WxSvrus.txt file to include the servers that you want it to use.

The Weather Wire Backup check box allows you to use Weather Wire as a backup for EMWIN.
Checking this box will cause the program to automatically start WxWW2000 when EMWIN data
is not available. This requires subscription and license for Weather Wire. See the Weather Wire
help for details.

When the program switches from Internet Ingest to WxWW2000, it will create a notification
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message in each ingest directory. The product identifier for this message is ADMWXM. If you
want to be alerted when the program switches between ingest sources, alarm the product
ADMWXM, with no state or county selected. The naotification message contains the current
ingest method and computer name.

A fixed TCP/IP server address can be used. Enter the fixed TCP/IP address in the Enter Fixed
Address field. Click on Use Fixed Address, to only connect to that specific server.

The Timeout seconds on loss of data is set by default to 15 seconds. The timeout can range
from 10 to 600 seconds. Setting this option to zero will disable the data loss timeout.

The Enable Version 2 option, when checked, will enable support for version 2 EMWIN packets.
This option is enabled by default and is the recommended setting.

Note: This program communicates with WxBBSrvr using UDP port 9510 on the local loop back
address.

46.4 Common Tab

The Common Tab is used to define options common or shared by all ingest programs.

Serial Ingast | Software Demod | Irtermet Ingest | Comman | |ngest Paths

Fiun in Background Log Bad Elocks ]
Log Received Files
IInZip Received Files

Purge Ingest Directories

K OEO

Enable Byte Blaster
Server Support

O

Log File Size ROOO0
[Global Ingest Paths

[ Save ] l Caricel

The Run in Background check box allows you to specify whether you want the ingest programs
to run in the background. When this box is checked, the ingest programs will not show in the
system tray. Once this option is enabled, you will not see the ingest programs running. In order
to see the ingest screen, you will need to use the Show Ingest menu option in Weather Message
Server.

Note: Changing this option does not take effect until the next time the ingest programs are
started.

The Log Received Files option causes the program to record the name of each weather file
received. The names are recorded in WsFiles.txt.
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The UnZip Received Files option, when checked, will cause the program to unzip any
compressed files. This option is normally left unchecked as the Weather Message programs
automatically unzip compressed files. In some applications it may be desirable to unzip the files
before they are copied to the ingest directory(s).

The Purge Ingest Directories option, when checked, will cause the program to automatically
purge the ingest directories after 24 hours.

If you are running the Byte Blaster server, WxBBSrvr, check the Enable Byte Blaster Server
Support box. This will cause the ingest program to create data records for processing by the
Byte Blaster server.

The Log File Size field allows you to specify this size of your ingest log files. The default is
50,000 bytes.

The Global Ingest Paths option controls whether WXEmwin uses global ingest paths. Global
ingest paths are shared between all of the ingest programs. Unchecking this box will allow you to
define ingest paths that are different from the global ingest paths.

The Log Bad Blocks option, when checked, will cause the program to log bad block information
in the associated ingest engine's log file.

4.6.5 Ingest Paths Tab

The Ingest Paths Tab is used to define the directories that will store the received weather
products for processing.

Serial Ingest | Software Demod | Intermet Ingest | Common | Ingest Paths

Ingest Path | c\dubd esgiia/vD atabFiFiles

Additional Distribution Paths

Save ] | Cancel |

The Ingest Path is defined in the Weather Message Server setup screen and would not normally
be entered here.

Note: The Ingest Path can be changed if you want to deposit the received messages in a
directory other than the one established for Weather Message Server.
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The Additional Distribution Paths can be used to place a copy of the received weather text in
different directories for processing by other programs. For example, if you use Weather
Message to receive your weather data, you can put a copy of the received messages in a second
or third directory for processing by RealEMWIN or the Weather Message Retransmission

program.

Note: Changing the Ingest and Additional Distribution Paths on this screen will automatically

change them for WxPort and WxWW2000.

© 2010 Weather Message Software






46 Weather Message - EMWIN Retransmission

5 WxWw2000 - Weather Wire Ingest
5.1  Overview

WxWW2000 is used by Weather Message for Internet or serial port Weather Wire data feeds.
The ingest program can be started automatically by the Weather Message Server or manually.

¥, WxWw2000 - Weather Wire Ingest [Z||E|E|

File  Source  Help
Status
D ats Source Internet - Connected
Received File RwRb 15:24:33
Last File RWwRSD 15:24:30
Connected

The main screen shows the status of incoming messages.
The Data Source field shows type connection type; Internet or Serial Port.

The Received File and Last File fields display the product identifier of the current and last files
received along with the their respective received times.

Note: Before WxWw2000 will connect to an Internet server you must enter your user name
and password in the setup screen. For more information about Weather Wire and registering,
see What is Weather Wire. To obtain a user name and password go to this web address
https://oi.weatherwire.net.

Note: If you are using the Internet ingest option, the program will alternate the program icon in
the system tray to let you know that it is connected.

Note: If WxWw2000 is stopped with the window minimized, the next time it is started, it will
start minimized.

System Tray

When WxWw2000 is minimized, you can restore the main screen by right clicking on the system
tray icon m then select open.
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Menu Options

%, WxWw2000 - Not Registered =3

File  Source  Register  Help

Status

[rata Source |ntermet - Connected

The menu buttons on this screen perform these functions:

The File menu allows you to setup this program, show details, view logdfiles, and exit the
program.

Conneck

Setup

Wiewn Logfile

‘Wiew Files Received Log

Exit

The Connect option starts a connection to the Internet servers.

The Setup option opens the Setup window.

The View Logfile displays the ingest log file in notepad.

The View Files Received Log displays the received files log in notepad.
The EXxit option shuts down WxIngest.

Note: In order to view the Files Received Log, the Log Received Files option must be
enabled.

The Source menu allows you to toggle between the Internet servers and serial port connection.

The Register menu allows you to register WxWW2000. This button does not appear if the
software is registered. Note: If the software is not registered after 60 days, it will stop functioning.

The Help menu allows you to see this manual, and display information about the program.

Weather Message Help
About

Weather Message on the Web
E-Mail Program Support
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5.3 Setup
5.3.1 Settings Tab

The Settings Tab is used to define the Internet settings, user name, password, communications
port and other general operations.

WxWw2000 Setup

Settings | Common | Ingest Paths

‘Weather wire URL | oj weatherwire. net l;zﬁj ;iie e
Wwieather Wire Port 15000 Intermet ®
User Mame WHmESg

Pazsword kbdmdd

Carnmn Part 1

Baud Rate 960081 w Marme by A4w1P5

Global Ingest Paths

Save l [ Cancel ]

Select the Ingest Type; Serial Port or Internet.

For Internet ingesting, you must specify the Weather Wire URL, Weather Wire Port, User
Name and Password. The program will provide defaults for the URL and port. You will need to
enter the User Name and Password that you supplied to DynaCorp when you signed up for this
service. To register for a user name and password go to this web address
https://oi.weatherwire.net.

For Serial Port ingesting, select the appropriate Comm Port and Baud Rate.

The Name by AWIPS option, when checked, causes the program to name the received files
using the AWIPS identifier found in the message, followed by the originating station's state
abbreviation. When it is not checked, the received files are named using the first 3 characters of
the AWIPS identifier, followed by the originating station's 3 character abbreviation, followed by
the originating station's state abbreviation.

The Global Ingest Paths option controls whether WxWw2000 uses global ingest paths. Global
ingest paths are shared between all of the ingest programs. Unchecking this box will allow you to
define ingest paths that are different from the global ingest paths.

5.3.2 Common Tab

The Common Tab is used to define options common or shared by all ingest programs.
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WxWw2000 Setup

Settings | Common | lngest Paths

Fun in Background FI
Lag Received Files
Purge Ingest Directories

Log File Size "O000n

[ Save l l Cancel

The Run in Background check box allows you to specify whether you want the ingest programs
to run in the background. When this box is checked, the ingest programs will not show in the
system tray. Once this option is enabled, you will not see the ingest programs running. In order
to see the ingest screen, you will need to use the Show Ingest menu option in Weather Message
Server.

Note: Changing this option does not take effect until the next time the ingest programs are
started.

The Log Received Files option causes the program to record the name of each weather file
received. The names are recorded in IBFiles.txt.

The Purge Ingest Directories option, when checked, will cause the program to automatically
purge the ingest directories after 24 hours.

The Log File Size field allows you to specify this size of your ingest log file, IBLog.txt. The
default is 50,000 bytes.

5.3.3 Ingest Paths Tab

The Ingest Paths Tab is used to define the directories that will store the received weather
products for processing.
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WxWw2000 Setup

Settings I:::umm-:un| Ingest Paths |

Ingest Path | W ubd eeghiweD atahF xFiles

Additional Distribution Paths

[ Save ] [ Cancel ]

The Ingest Path is defined in the Weather Message Server setup screen and would not normally
be entered here.

Note: The Ingest Path can be changed if you want to deposit the received messages in a
directory other than the one established for Weather Message Server.

The Additional Distribution Paths can be used to place a copy of the received weather text in
different directories for processing by other programs. For example, if you use Weather
Message to receive your weather data, you can put a copy of the received messages in a second
or third directory for processing by RealEMWIN or the Weather Message Retransmission
program.

Note: Changing the Ingest and Additional Distribution Paths on this screen will automatically
change them for WxByte, WxIngest, and WxPort.

5.4  Register Software

The Register menu option allows you to register your software.

Register, Sofiware |E|

Fegistration Mame | |

Fegistration Code | |

[ Cancel ] [ Reqister l
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When you purchase WxWw2000, you will be supplied with a Registration Name and
Registration Code. Enter these exactly as they are printed. These fields are case sensitive.

After the software is registered, we recommend that you stop and restart the software.

To purchase the software go to http://www.wxmesg.com/purchpay.htm.
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6

6.1

WxRadar

Overview

WxRadar is a support application that can be used to automatically retrieve radar images. It can
retrieve a specific radar site for viewing on the screen, or schedule single or multiple radar sites
for ingesting by Weather Message or other programs. WxRadar requires Internet access.

If you plan to use WxRadar to retrieve images on a schedule, it should be placed in the startup
box in Windows. This will insure that the program is automatically started each time the
computer is booted.

® WxRadar FE®
File  Schedule  Retrieve Mow  Help
state (aL o« | Radarsite | KMd - BIRMINGHAM - East dlabama Camville
mage
Lavers [ ] Topo Fadar Counties Rivers Highways
Citie:s Warnings Legend

Mational Westher Y Image from: TM72006 1243 UTC (e

Received KX image at 06:55:42.

When scheduling radar images, the images that are received will be copied to directories for
other programs to process. You can use it in conjunction with Weather Message to FTP images
to a website or WxReTran for EMWIN retransmission. See Scheduling.

Images processed by Weather Message Server can be made available to the Weather Message
Client Image Viewer. The Image Viewer can then be used to animate the received radar images.

Note: If WxRadar is stopped with the window minimized, the next time it is started, it will start
minimized.

System Tray

When WxRadar is minimized, you can restore the main screen by right clicking on the system
tray icon ﬂ then select open.
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6.2 Menu Options

File  Schedule  Retrieve Mow  Help

state a1« RadarSite | KM - BIRMINGHAM - East Alabama Carrville

lmaoe [ e |

The menu buttons on this screen perform these functions:

The File menu allows you to setup this program, view lodfile, print the current radar image and
exit the program.

Setup
View Log

Print

Clear Cache

Ezxit

The Setup option opens the Setup window.

The View Logfile displays the radar log file in notepad.

The Print option prints the current radar image on your default printer.

The Clear Cache option clears the radar cache directory of all static image overlays.
The Exit option shuts down WxRadar.

The Schedule menu allows you to establish a schedule to retrieve radar images.
The Retrieve Now menu forces the application to start a retrieve cycle.

The Help menu allows you to see this manual, and display information about the program.

WWeather Message Help
Abouk

‘Weather Message on the Web
E-Mail Program Support
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6.3 Main Window

® WxRadar g@!\

File  Schedule  Refkrieve Mow  Help
State (sl « | RadarSite | KM - BIRMINGHAM - East Alabama Carrvile

Layers [ | Topo Fadar Counties Riiwvers Highways
Cities Warnings Legend

Image

[ational

Received KhXX image at 065542,

The main window allows you to quickly retrieve a radar image. Select the State, Radar Site,
Image type and Layers. Click the View button to retrieve the image selected.

Hint: To receive national radar products, select the state abbreviation NA.

The image can be resized to fit the display window or zoomed for closer inspection. To activate
these features, right click on the image and select one of the displayed options.
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Pan

Zoarm In

Zoorn Ouk

BLE &

Zoom Window

o
=]

Zoam 100%:

Zoarm Fik

2 Be

tagnify

Zoarn e00%:
Zoarm $00%:
Zoam 200%:

Zoam 5%
Zoorn 50%:
Zoarm 25%:

Zoam 10%:

The default view is Zoom 100%.

To print the displayed image, click on the File menu and select Print. The image will be printed to
your default printer.

Note: If WxRadar cannot download the requested radar image, a "Radar Unavailable" image

will be displayed. The "Radar Unavailable" image can be customized by changing the
"RadUnavl.gif" file.

6.4  Scheduling

To schedule radar images for automatic retrieval, click on the Schedule menu. The main window
will change to allow you to setup schedules.
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,' WxRadar Z E' le

File  Preview  Retrieve Mow  Help

State |aL w | FadarSite  |KMs - BIRMINGHAM - East Alabama Carrille %

Irmage Reflectivity 124 miles

Layers  [] Topo Radar Counties Rivers Highways
Cities Warnings Legend

Radar Site Interval Image File Mame

kB b B Minutes  Reflectivity 124 miles RaDB bl :
A b A Minutes  Reflectivity 124 miles RAD AL :
K.B b AkMinutes  Reflectivity 248 miles RADBM2AL :
Kb AMinutes  Reflectivity 248 miles RaD b0l :
< b

Interval |5« | Minutes  File Mame

705 Ak - RADMSZAL gif copied to ingest.

Select the State, Radar Site, Image, Layers, File Name for ingest and Interval to retrieve. Click
on the Add button to schedule that radar site. To remove a site, click on the site in the list and
click the Delete button.

Hint: To receive national radar products, select the state abbreviation NA.

Note: If you do not enter a file name, WxRadar will create the radar file name in the format,
"RAD" plus the last three letters of the radar site plus the 2 digit state abbreviation plus ".gif".
For example, the file name for KMXX would be RADMXXAL.gif.

The scheduled radar images will be retrieved based on the interval period specified. Valid
intervals are 4, 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15, 20, 25, 30, 35, 40, 45, 50, 55 and 60 minutes.

The results of each scheduled retrieve is logged to the file RadLog.txt. To view this log file, click
on File and View Log. The log file will contain an entry for each time it attempts to retrieve a
radar image. It will also contain any error conditions.

Hint: The scheduled images will be retrieved according to the schedule you establish. If you
want to retrieve all images immediately, click on the Retrieve Now menu button.

When you are finished entering your schedule, click on the Preview menu. This returns you to
the Main Window.
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6.5 Setup
6.5.1 Settings Tab

The Settings Tab is used to define general program operation.

WxRadar Setup

Settings | |ngest Paths

Timeout [seconds] | 240 | Firewall # Prowy |
Log File Size RO000
Show Image I tap Background ] -
Drop Duplicates Irmage Type GIF 3
IJze Defined Ingest Paths Auto Startup Mo >
Send to Client Viewer Fi

I Save I I Cancel

The Timeout field allows you to specific the maximum amount of time the program will wait on
the NOAA servers to respond.

The Log File Size field allows you to specify this size of your log file, RadLog.txt. The default is
50,000 bytes.

When the program retrieves images from the defined schedule, it does not display these images
in the preview window. The Show Image check box, when checked, causes the program to
show each image as it is received.

The Drop Duplicates check box, when checked, will create a CRC32 checksum on each
received image. If the next image received is a duplicate, the program will not process the
image.

The Use Defined Ingest Paths check box, when checked, will cause the program to use the
ingest paths defined in the ingest programs, WxByte and WxIngest. If you want to define your
own ingest paths for WxRadar, remove this check.

The Send to Client Viewer option, when checked, will cause the program to store a copy of the
image for viewing by the image viewer built into the Message Client. This option can be used in
special situations where radar images are not being processed by Weather Message Server.
The user can configure WxRadar to process radar images and place them in the local WxImages
directory for viewing in the Message Client.

The Firewall / Proxy button allows you to configure Firewall and Proxy settings for your
computer. See Firewall / Proxy.
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The Map Background button allows you to set the color of the radar image background.

The Image Type list allows you to select an image format for the received image. Radar images
are received by default in GIF format. You can select GIF, JPG, PNG, BMP, and TIF formats.

The Auto Startup option allows you to specify whether WxRadar is automatically started when
Windows starts. The options are No; Yes, for the current user; and Everyone, for any user.

Note: The options available for Auto Startup are based on your user permissions.
Administrator and Power users will have all of the options. Other users may only have the Yes

option.

6.5.1.1 Firewall / Proxy

The Firewall / Proxy window allows you to configure firewall / proxy information for your

computer.
Firewall f Proxy Settings

Firewwall Hitp | Prowy

Host Name

Part 0

Ilzer Mame

Paszword

Type 3-Socks5 W

Save ] [ Cancel

For a HTTP firewall, enter the domain name or TCP/IP address of the firewall in the Host Name
field.

Enter the Port number for the firewall.

If required, enter a User Name and Password. This should be a user name and password
setup in the firewall.

Select the Type of firewall. Valid entries are 1-Tunnel, 2-Socks version 4, or 3-Socks version 5.

© 2010 Weather Message Software



WxRadar 61

Firewall f Proxy Settings

| Firewall Hitp | Prosy |

Host Mame 192 168.0.1 HTTPYersion 1.0 []
Port

Uszer Name |:|

Password |:|

Detect Proxy

Save ] [ Cancel ]

For a Proxy access, enter the domain name or TCP/IP address of the proxy in the Host Name
field.

Enter the Port number for the firewall.

If required, enter a User Name and Password. This should be a user name and password
setup for the proxy.

If HTTP version 1.0 is required for the proxy server, check this box.

The Detect Proxy button will automatically detect the proxy settings for your computer and
populate the host name and port fields.

Note: The Firewall / Proxy settings are common to all Weather Message applications.
Changing these settings will automatically change them for the other applications.

6.5.2 Ingest Paths Tab

The Ingest Paths Tab is used to define the directories that will store the received weather
products for processing.
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WxRadar Setup

Seftings | Ingest Paths |

Ingest Path |l::'\W:-:Mesg"\w:-:data'\eriles

Additional Distribution Paths

| Save | | Cancel |

The Ingest Path is defined in the Weather Message Server setup screen and would not normally
be entered here.

The Additional Distribution Paths can be used to place a copy of the received weather text in
different directories for processing by other programs. For example, if you use Weather
Message to receive your weather data, you can put a copy of the received messages in a second
or third directory for processing by RealEMWIN or the Weather Message Retransmission
program.

Note: If the Use Defined Ingest Paths setting is checked, you will not be able to change the
paths listed.
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7 Supplemental

7.1 Upgrading from a Previous Version
If you are upgrading a version of retransmission software provided from Maryland Radio Center,
Xenocode, or Emwin Pro, the following information will be helpful.
Upgrade from 16-bit version.

To upgrade from the 16-bit version, install WxReTran according to this manual. After installation,
copy the following files to their corresponding WxReTran file.

C:\weather\mrcfiles.txt c:\WxMesg\FillFile.txt
C:\weather\hipri.txt c:\WxMesg\RtListl.txt
C:\weather\normal.txt c:\WxMesg\RtList5.txt
C:\weather\compress.txt c:\WxMesg\RtList9.txt
C:\weather\delete.txt c:\WxMesg\RtListll.txt
C:\weather\txsked. txt c:\WxMesg\RtSched. txt

Check all of the setup screens and enter information for your retransmission site.
Note: The 16-bit version processed all priority lists before checking the discard list.

WxReTran processes the discard list first, because of this, you may need to change the file
names that appear in the discard list.

If you use the scheduler, you will need to change the paths associated with the source file and
destination priority directory. Failure to do so will cause your schedule to be ignored.

Note: The path "c:\WxMesg\" refers to the directory that you installed WxReTran. If you
installed the program in a different directory, use your installation path.

Upgrade from 32-bit version.

To upgrade from the 32-bit version, install WxReTran according to this manual. After installation,
copy the following files to their corresponding WxReTran file.
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C:\weather(fillfile.txt c:\WxMesg\FillFile.txt
C:\weather\prilstO.txt c:\WxMesg\RtListO.txt
C:\weather\prilstl.txt c:\WxMesg\RtList1.txt
C:\weather\prilst2.txt c:\WxMesg\RtList2.txt
C:\weather\prilst3.txt c:\WxMesg\RtList3.txt
C:\weather\prilst4.txt c:\WxMesg\RtList4.txt
C:\weather\prilst5.txt c:\WxMesg\RtList5.txt
C:\weather\prilst6.txt c:\WxMesg\RtList6.txt
C:\weather\prilst7.txt c:\WxMesg\RtList7.txt
C:\weather\prilst8.txt c:\WxMesg\RtList8.txt
C:\weather\prilst9.txt c:\WxMesg\RtList9.txt
C:\weather\prilst10.txt c:\WxMesg\RtList10.txt
C:\weather\prilst11.txt c:\WxMesg\RtList11.txt
C:\weather\prilst12.txt c:\WxMesg\RtList12.txt
C:\weather\schedule.txt c:\WxMesg\RtSched.txt

Check all of the setup screens and enter information for your retransmission site.

If you use the scheduler, you will need to change the paths associated with the source file and
destination priority directory. Failure to do so will cause your schedule to be ignored.

Note: The path "c:\WxMesg\" refers to the directory that you installed WxReTran. If you
installed the program in a different directory, use your installation path.

7.2 Interface Specifications

WxReTran communicates with your external modulator/modem to send the EMWIN data. The
following RS232 connections should be made, depending on your interface.

RS232 Pin

Description

2

Transmit data — Outgoing EMWIN data

4

Request to Send (RTS) — Push to Talk (PTT)

7

Ground

20

Data Terminal Ready — Power for modulator

WxRetran will set the DTR line high when the program starts. The DTR line can be used to
supply power to the modulator. The RTS line goes high when the program wants to transmit
data. The program will wait a user definable amount of time after switching the PTT on before
transmitting data. This will insure that the transmitter has adequate time to come up.

Morse code, used for radio identification, is generated by turning the PTT on and off. If your
modulator/modem does not support identification by this method, external circuitry will be

required.
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The modulator will need to be connected to your transmitted. See the modulator instructions for

installation specifics.

Note: If you plan to transmit EMWIN data at all times, you will need a continuous duty
transmitter. A continuous duty transmitter is rated for this type of service. Ordinary
transmitters do not have adequate cooling for continuous service. Consult your local two-way

radio dealer for information.
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8 Software License

LICENSE AGREEMENT

I. LICENSE GRANT.
Danny Lloyd, hereafter referred to as Author, grants you a non-exclusive license to use the
software known as WxMesg, or Weather Message, hereafter referred to as Software.

. DISCLAIMER OF WARRANTY.
Software is provided on an "AS IS" basis, without warranty of any kind, including without
limitation the warranties of merchantability, fithess for a particular purpose and non-
infringement. The entire risk as to the quality and performance of the Software is borne by you.
Should the Software prove defective, you and not Author assume the entire cost of any service
and repair. In addition, the security mechanisms implemented by Author software have
inherent limitations, and you must determine that the Software sufficiently meets your
requirements. This disclaimer of warranty constitutes an essential part of the agreement.
SOME JURISDICTIONS DO NOT ALLOW EXCLUSIONS OF AN IMPLIED WARRANTY, SO
THIS DISCLAIMER MAY NOT APPLY TO YOU AND YOU MAY HAVE OTHER LEGAL
RIGHTS THAT VARY BY JURISDICTION.

[ll. SCOPE OF GRANT.

You may:

e use the Weather Message WxRetran and WxBBSrvr on any number of computers;

e copy the Software for archival purposes, provided any copy must contain all of the original
Software's proprietary notices.

You may not:

e permit other individuals to use the Software except under the terms listed above;

e modify, translate, reverse engineer, decompile, disassemble (except to the extent applicable
laws specifically prohibit such restriction), or create derivative works based on the Software;

e rent, lease, grant a security interest in, or otherwise transfer rights to the Software; or

e remove any proprietary notices or labels on the Software.

IV. TITLE.
Title, ownership rights, and intellectual property rights in the Software shall remain in Author.
The Software is protected by copyright laws. Title and related rights in the content accessed
through the Software is the property of the applicable content owner and may be protected by
applicable law. This License gives you no rights to such content.

V. TERMINATION.
The license will terminate automatically if you fail to comply with the limitations described
herein. On termination, you must destroy all copies of the Software.

VI. LIMITATION OF LIABILITY.
UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT, CONTRACT, OR
OTHERWISE, SHALL AUTHOR OR ITS SUPPLIERS OR RESELLERS BE LIABLE TO YOU
OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION,
DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR
MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR LOSSES. IN NO
EVENT WILL AUTHOR BE LIABLE FOR ANY DAMAGES IN EXCESS OF THE AMOUNT
AUTHOR RECEIVED FROM YOU FOR A LICENSE TO THE SOFTWARE, EVEN IF AUTHOR
SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY
CLAIM BY ANY OTHER PARTY. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO
LIABILITY FOR DEATH OR PERSONAL INJURY TO THE EXTENT APPLICABLE LAW
PROHIBITS SUCH LIMITATION. FURTHERMORE, SOME JURISDICTIONS DO NOT
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ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THIS LIMITATION AND EXCLUSION MAY NOT APPLY TO YOU.

VII. HIGH RISK ACTIVITIES.

The Software is not fault-tolerant and is not designed, manufactured or intended for use or
resale in computer systems, in which the failure of the Software could lead directly to death, or
personal injury. Author specifically disclaim any express or implied warranty of fitness for High
Risk Activities.

VIIl. MISCELLANEOUS.
This Agreement represents the complete agreement concerning this license and may
amended only by a writing executed by both parties. If any provision of this Agreement is held
to be unenforceable, such provision shall be reformed only to the extent necessary to make it
enforceable. This Agreement shall be governed by the laws of the state of Alabama.
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